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Preface

The objective of AutoCAD® Level 1 Essentials is to enable students to create and edit basic 2D drawings in AutoCAD 
using the command tools that are mostly used in an everyday CAD drawing session. Even at this fundamental level, 
AutoCAD® is one of the most sophisticated computer applications that users are likely to encounter. Learning to use it 
is therefore not a trivial undertaking.

To make the student learning process easier and provide as much Hands-On experience as possible students will be 
participating in "hands on" lecture sessions led by the instructor followed by the completion of "hands on" exercises 
to reinforce the materials taught.

This Student Guide is intended for a 4 day class in the fundamentals of using AutoCAD. AutoCAD Level 1 Essentials 
covers the indispensable core topics for working with AutoCAD. The teaching strategy is to start with a few basic tools 
that will let the student create and edit a simple drawing. Then we continue to develop those tools, as well as introducing 
more advanced tools throughout the course. Not every command or option is covered, because the intent is to show the 
most used tools and concepts that apply in working with AutoCAD within the 4 day class schedule:

 ■ Understanding the AutoCAD workspace and user interface

 ■ Using viewing tools, coordinates, basic drafting tools and setting up drawing units

 ■ Creating and editing 2D geometry, lines, circles, arcs, polylines and points

 ■ Editing 2D geometry

 ■ Managing object properties, organizing drawing objects on layers

 ■ Using CAD construction technique tools

 ■ Creating text, defining text styles and editing text

 ■ Creating local and global symbol blocks

 ■ Inserting reusable symbols blocks

 ■ Using Symbol Tool Palettes including DesignCenter and Idrop blocks

 ■ Using dimension tools, creating dimension styles and editing dimensions

 ■ Introduction to hatching and editing patterns

 ■ Plotting concepts

 ■ Preparing a layout to be plotted in paperspace with pen assignments
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Note on "Hands-On" Lectures and Exercises

This course is designed for all lectures to be done with students participating in Instructor-Led "Hands-On" lecture 
sessions.

Following the lecture sessions students will perform a "hands on" exercise, or lab, on each major topic. The class schedule 
is designed to allow the students to complete all Hands-On exercises in the book.

Due to the number of students in class, speed and time frame to finish the class on time the Instructor may have to 
combine an exercise or two with the lecture to save time. 

The unique "pictorial" design of CyberTek Publishing LLC training manuals is tremendously beneficial to the students 
in terms of learning methodology and retention of the material. In addition, our training manuals greatly enhance the 
teaching process for instructors as students will easily be able to navigate through the exercises, usually without any 
difficulties at all

Note on Optional Hands-On Exercises & Advanced Topics

The Optional Hands-on exercises and Advanced Topics are intended as supplemental learning material and may be 
included, or not, as determined by the pace of the class at the discretion of the instructor.

These exercises and topics are intended for the student to learn more on their own time in reviewing the book and 
studying after class.

For smaller classes, or classes that are running ahead of schedule, then these exercise topics may be used to give students 
additional "hands on" practice.

These topics and exercises will be up to the instructor and based on the class schedule.

To download the exercise files for any CyberTek Publishing training title go to:

http://www.ctpub.net > Choose Downloads from the menu bar

If you need the current version of AutoCAD software to work with while using this training manual you can download 
a free 30 day trial version from Autodesk:

Autodesk Download Site: http://usa.autodesk.com/products/free-product-trialsSam
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Notes On Symbols And Text Conventions

Throughout the pages of CyberTek Publishing LLC courseware you will encounter symbols and text conventions that 
you will become familiar with as you navigate the pages of our AutoCAD®, Revit®, and Inventor® courseware.

Following are the symbols and text conventions that you see in our courseware:

A
Left-Click Mouse Symbol This mouse symbol always indicates a left mouse click action 

referring back to a step in a lecture or exercise sequence.

A
Right-Click Mouse Symbol This mouse symbol indicates a right mouse click action refer-

ring back to a step in a lecture or exercise sequence.

A
Double-Click Mouse Symbol This symbol designates a double mouse click action referring 

back to a step in a lecture or exercise sequence.

A Action Step Letter A circled letter indicates an alphabetical action step sequence 
referring back to a step in a lecture or exercise sequence.

1 Action Step Number A circled number indicates a numberical action sequence 
referring back to a step in a lecture or exercise sequence.

Function Key Symbol Keyboard symbols such as this indicate a Keyboard Function 
Key command.

<Ctrl> Ctrl/Alt Keyboard Commands This convention indicates a Ctrl or an Alt key plus a second 
key to execcute a particulate AutoCAD command.
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Setting Up AutoCAD

 • Choosing a Start Up Menu
 • Creating a Workspace
 • Setting AutoCAD Options

Using the AutoCAD Interface

 • Using the Command Ribbon
 • Using Pull-Down Menus
 • Using Toolbars
 • Using AutoCAD Palettes

Working in AutoCAD’s Spaces

 • Using Model Space to Draw
 • Using Paper Space for Layout Plots

Communicating With AutoCAD

 • Reading Command Prompts
 • Using Command Options
 • Right-click Shortcut Menus

Learn How to Get Out of Trouble

 • Canceling Commands
 • Using the Undo & Redo Commands
 • Using AutoCAD’s On-Line Help

Saving Your Work

 • Using Qsave Command
 • Using SaveAs Command
 • Using Save Command
 • Setting the Automatic Save

1: Learning How to Work with AutoCAD
Learning Objectives: This section introduces new users to AutoCAD and familiarizes them with the software, 
the terminology, the command structure prompts, command options and generally how to use AutoCAD.

Getting To Know AutoCAD

This chapter is intended to introduce new users to AutoCAD.

The first section of this book is to setup AutoCAD Workspaces that will be used throughout the book. This book can be 
used to teach AutoCAD using the new Ribbon features or for older releases using the Pull-down menus and toolbar.

The purpose of this chapter is to explain how AutoCAD works and get new users familiar with the terminology, set-
ting up the software, the command structure, prompts and command options. (Everything covered in this chapter will 
be expanded upon as the course progresses).

Class Instructions:

This section can be taught by Instructor/Student Hands-On Lecture or by Instructor Lecture with students completing 
the Examples and Hands-On Exercise.

Self Study:

Users learning AutoCAD on their own using this course material should read the Lecture pages and complete the 
Hands-On Exercises.

When used as a self study manual users will find that the lectures are written in simple terms explaining the commands 
and the exercises are made with step-by-step instructions to walk the user through the exercises.
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Starting AutoCAD

Initial AutoCAD Default 
Startup.

By default when you start up 
AutoCAD it will go straight into 
AutoCAD using the ACAD.
DWT template file to start a 
new drawing file.

AutoCAD will also open in the 
default 2D Drafting & Annota-
tion Workspace.

AutoCAD does have an Op-
tional Startup Menu that can 
be used. By default this menu 
is turned off.

Using this menu is a User 
Preference, each way has its 
benefits. 

Windows Desktop

There should be an AutoCAD 
Icon Tool on your desktop 
after installing the AutoCAD 
software. Simply double-click 
on the Desktop Icon to launch 
the software.

Windows Start Button

As with all Windows software 
you can use the Windows Start 
button. Then select All Pro-
grams in the Windows menu. 
In the Programs menu you can 
select the Autodesk program, 
then go to AutoCAD and select 
the software that you wish to 
open.
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Optional Startup Menu

Once AutoCAD is running and 
you select the New drawing 
command it will take you to the 
Template dialog box (A) so that 
you can select the template file 
to use to start a new drawing.

You can setup AutoCAD to 
show a Startup dialog box when 
you launch AutoCAD or start a 
new drawing (B).

If you are new to AutoCAD 
it maybe easier to understand 
what you are doing using this 
approach. 

NOTE: This is an option and 
not required.

Startup Menu Buttons

Select an appropriate button in 
the Startup dialog box to open 
existing drawings or create new 
drawings.

Turning on the STARTUP Menu:
At the command prompt type STARTUP <Enter>
At the new value prompt type 1 <Enter>

Note:

The Open a Drawing button will only appear when you first startup AutoCAD. 
Once inside AutoCAD you will have to use the OPEN command to open existing 
AutoCAD drawing files.

Open a Drawing

Start from Scratch

Use a Template

Use a Wizard

A

B
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AutoCAD Workspaces

AutoCAD Classic Work-
space

The AutoCAD Classic Work-
space uses the Pull-down menus 
and Toolbars with the same 
interface spanning releases from 
2000 through 2008.

Note:
Using this Workspace will en-
able students using older re-
leases to still learn AutoCAD 
and the command structure.

Drafting & Annotation

A default  instal lat ion of 
AutoCAD provides a workspace 
that is tailored to drafting and 
annotation tasks. The first time 
you start AutoCAD, the Draft-
ing & Annotation workspace 
is active.

The Drafting & Annotation-
Workspace uses Ribbons (new 
to AutoCAD 2009).

The Drafting & Annotation workspace provides most of the 2D drafting and an-
notation commands on panels in the Ribbon instead of on traditional toolbars. 
This streamlined workspace does not include toolbars such as Draw, Modify, and 
Styles, although all of the toolbars are available if you choose to use them.
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Creating and Saving Workspaces

AutoCAD users vary greatly 
in the way they like to use 
and access commands. Some 
like to type hotkeys, others 
prefer Toolbars for quick and 
easy access to commands. 
Many users like to use pull-
down menus and others pre-
fer the Ribbons. The power 
of AutoCAD is that it does 
not limit the user to a single 
method for accessing com-
mands.

Workspaces
In this example you will setup 
a Custom Ribbon Workspace 
to use with this book.

Custom Ribbon Workspace With Pull-down Menus

Custom AutoCAD Classic Workspace 
With Standard Toolbars Loaded

Workspaces

Creating a Custom Work-
space to be used with this 
book.

1) If Not in the Drafing & 
Annocations - Select the 
Workspace Icon (A) at the 
bottom right of the Status Bar.

2) Select the Drafting & An-
notation workspace (B).

B

A
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Optional Hands-On

3) Select the down arrow 
on the right of the Quick Ac-
cess toolbar (A).

4) In the drop-down menu 
select Show Menu Bar (B) 
to turn on the Pull-down 
menus.

User now has the benefit of using both 
the Pull-down menus and Ribbon 
Panels to access commands. There are 
a few commands that are not located 
in the Ribbon and can be access in the 
Pull-down menus.

A

B
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Workspaces:

7) Decide if you want to use 
the Icons on the Status Bar for 
Snap, Grid, etc or the buttons 
with names. Right click on 
any icon on the Status Bar 
and turn on/off the Use Icons 
(A), (B).

Workspaces:

8) Select the Application 
Status Bar Menu button 
(black triangle) at the bottom 
right of the status bar (A).

9) In this menu you can turn 
on and off the Icon tools that 
you will not be using. such as  
Zoom, Pan, SteeringWheel, 
etc (B).

10) The Status Toggles cas-
cading menu lets you turn off 
the buttons on the left side of 
the status bar that you may 
not need if your work type 
doesn’t use them (C).

B

C

A

B

A

B

A

Icons By Default

Named ButtonsWhen 
Use Icons Is Off
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Workspaces:
11) Adjust the Command 
Prompt so that you have 3 
lines of text. Move the cursor 
on the top line of the command 
prompt (A) and drag it till you 
have 3 lines of text.

12) On the Quick Access 
toolbar select the list arrow (B) 
to open the options menu.

13) In the drop down list se-
lect Save Current As... and 
type the name MY RIBBON 
WORKSPACE (C) and select 
the Save button..

Using Options to Setup 
AutoCAD

The Options Dialog Box is 
where you will configure the 
settings for AutoCAD, such 
as, the color of the drawing 
window, etc.

You will learn some of these 
settings as you go through the 
course.

At this time it is only necessary 
to know about this feature and 
the commands settings.

A

B
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Display Tab:

1) In the Options dialog box 
select the Display tab (A).

2) Under the Show Tool 
Tips section unchecked the 
Show Shortcut keys  & 
Show extended ToolTips 
(B).

3) Unchecked the Show roll-
over ToolTips (C).

4) Under the Layout Ele-
ments section Check the 
Show Page Setup Manager 
for New Layouts (D).

Here are some suggestions for beginning users to think about when setting up AutoCAD for their type of work.

Right-click in the drawing area and select Options from the Shortcut menu.

Display Tab:
5) Select the Colors Button 
(A):
• Set the 2D Model Space 

background color, white, 
black, etc.

• Set Sheet/Layout back-
ground color, white, black, 
etc.

• Select Apply & Close 
Button.

6) Select the Fonts Button 
(B):
• Set the font type for your 

Command Prompt & 
Text Window.

• Set the Font Style and 
Size.

• Select Apply & Close 
Button.

AB

C

B

A

D
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Open & Save Tab:

7) Check the Automatic 
Save  (A) and set the time to 
30 minutes.

Plot & Publish Tab:
8) Set the Default Output 
Device (B) to your default 
Printer. Set the Save Plot 
Log  (C) to your choice.

A

B

C
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3D Modeling Tab
AutoCAD LT users will not 
have this section and continue 
on to the next section

1) Uncheck the Display 
ViewCube (A) in the 2D 
model space in the Display 
ViewCube or UCS Icon sec-
tion.

2) Uncheck the Display 
Viewport controls (B)

3) Select the OK button 
when finish.

Saving Changes to an Exist-
ing Workspace

1) On the Quick Access 
toolbar select the list arrow (A) 
to open the options menu.

2) Enter the same name that 
you gave to your workspace 
and select Save (B).

3) In the Workspace – Al-
ready Exist dialog box select 
the Replace button (C).

A

A

C

B

B
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AutoCAD Interface Overview

Drafting & Annotation

Application Menu ................

Quick Access Toolbar ..........

Ribbon Tabs ........................

Ribbon Panels ......................

This illustration shows the main 
components of AutoCAD and 
the names and terms used.

Windows Title Bar ...............

Toolbars ...............................

Pull-Down Menus ...............

Drawing Area .......................

Model & Layout Tabs ..........

Ucsicon Display ...................

Command Prompt ...............

Status Bar .............................

AutoCAD Classic
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AutoCAD Ribbon

The Ribbon provides a single, 
compact placement for op-
erations that are relevant to the 
current workspace. It eliminates 
the need to display multiple 
toolbars, reducing clutter in the 
application and maximizing the 
area available  for work using a 
single compact interface.

The Ribbon displays automatically when you create or open a drawing using either the Drafting & Annotation 
workspace. You can also open the Ribbon manually

• Click Tools menu>Palettes>Ribbon
• At the Command prompt, enter ribbon.

AutoCAD Ribbon Bar

The Ribbon has four settings 
that can used when working 
with the Ribbon.

Fully Maximized: By default 
both tabs and panels are vis-
ible.

Minimize to Panel Tabs: Only 
the tabs are visible.

Minimize to Panel Titles: 
Both the tabs and panel names 
are visible.

Minimize to Panel Buttons: 
Panels are shown as icons, se-
lect a icon and only that panel 
opens.

Fully Maximized

Maximize to Panel Buttons

Minimize to Tabs

Some ribbon panels display a drop-down 
arrow next to the panel name. The drop-
down arrow indicates there are additional 
commands related to that panel. Click the 
drop-down arrow to access the additional 
commands on that panel.

Minimize to Panel Titles

The Ribbon is compose of 
a series of Panels which are 
organized into Tabs labeled by 
Task.
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Pull-down Menus

The pull-down menus provide 
easy access to AutoCAD com-
mands and settings.

• Command names like 
Line (A) Ray, Polyline, etc 
are instance commands. 
When selected they will 
start that command.

• When you move the cur-
sor over a command name 
with the block triangle on 
the right side (B) it will 
automatically open a cas-
cading menu with more 
commands and macros.

• Command names that 
are followed by..., such as 
Table... and Hatch...(C) 
will start the command 
and open a dialog box.

B

C

A

Turning the Pull-Down 
Menus on

On the Quick Access toolbar 
and on the right side of the 
Work Space list left-click on 
the drop down list to open the 
Quick Access menu options.

In the list menu select the 
SHOW THE MENU BAR to 
turn on the default Pull-Down 
Menus on.

Note: Most commands are 
located in the ribbon but there 
are some that are not. And as 
a user preference you can cut 
down key strokes using the 
menus instead of having to 
change Ribbon Tab and then 
changing back to the previous 
tab.

Cascading Menus provide 
easy access to command

options by Macros
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Toolbars

Toolbars provide a fast access 
to commands without having 
to open a pull-down menu and 
then select the command.

• Toolbars can be either free 
Floating or Docked to the  
top, sides or bottom of the 
drawing area (A).

• To Open a toolbars simply 
Right-click on any icon 
button (B) and select the 
toolbar to open.

• To move toolbars around 
and to dock them hold the 
Left-click mouse button 
down on the Drag Bar (C) 
and drag it to the location 
you desire.

• Hold the cursor over an Icon 
button to get a Tooltip for 
that command (D).

A

C

B

D

Icon Tool Tip
Toolbar is Closed

Toolbar is Open

Drag Bar for moving, 
docking & undocking.

Toolbars

Toolbars provide a fast access 
to commands without having 
to open a pull-down menu or 
changing the Ribbon tabs and 
then having to open a drop 
down list and then select the 
command. Then having to 
changing back to the previous 
tab.

• On the Ribbon select the 
View tab to open the View 
Panels.

• On the User Interface panel 
select the Toolbars icon to 
open the drop-down list and 
select AutoCAD to open the 
Toolbars menu.

• On the toolbar menu select 
the toolbar to open.
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Model Space

Model Space is where you will 
be doing most of your drawing 
work.

You will always draw geometric 
objects at full scale (1:1).

But, text, dimensions, and 
other annotation elements will 
be drawn at a scale that will 
appear at the correct size when 
the drawing is plotted.

Tool Palettes

Tool Palettes are a cross between 
dialog boxes and toolbars.

They can be "Floating" in the 
drawing area where they are 
not "Docked" and can be set to 
Auto Hide when not in use.

The can also be Docked to the 
side of the screen or set to be 
Anchored to the left or right 
side of the drawing area.

A list of commands that uses 
Tool Palettes can be found in 
the Tools pull-down menu 
under the Palettes cascading 
menu.

Model Space vs Paper Space (Layouts)

TOOL PALETTES

Auto Hide
Floating

Docked

Anchor Left
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Paper Space - Layouts

Layouts are used to prepare 
the model space drawing for 
plotting. Layouts are your Plot 
Sheets.

You can create multiple layouts 
of the model in the same draw-
ing file and each layout can use 
different sheet sizes and plot-
ting parameters and you can 
control layers between different 
layouts.

Once a layout has been setup 
the plot information is saved 
with that layout making repeat 
plotting fast and easy.

All layouts are plotted at a plot 
scale of 1:1.

Layouts

After you set up the plot sheet 
and printer, etc you then create 
viewports to show the model 
views as needed.

Viewports are then Zoomed to 
a scale factor for that view and 
then locked so that the scale of 
the viewports will not change 
when working inside of them.

You can also control layers be-
tween viewports and layouts.

This topic will be fully covered 
in the Page Setup and Plotting 
section of this book.
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Command Access Guide

At the back of the book is a 
Command References section 
that has a Command Access 
Guide for a quick reference on 
the different ways to activate 
and use AutoCAD commands.

This section also contains a list 
of Function Keys, Shortcut 
Keys, Ribbons and Toolbars.

Starting Commands

You can start most commands 
in several ways using most of 
the menus. All commands can 
be typed in and most have Alias 
(hotkeys). There are a few com-
mands that must be typed in.

For example the image shows 
the different ways to start the 
LINE command.

•	 Ribbon	Bar	(A)
•	 Pull-down	Menus	(B)
•	 Toolbars	(C)
•	 Typing	in	the	Command	

(D)

Communicating With AutoCAD

Draw pull-down 
menu > LINE

Ribbon> Home Tab > 
Draw Panel> LINE

Command Prompt Type 
“LINE” or “L” <Enter>

C

B
A

D
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AutoCAD Command Structure and Options

DEFAULT COMMAND INPUT: When you first start an AutoCAD command the first thing you will see in the 
command prompt is the Default information that AutoCAD wants from you.
Example: In the Circle command AutoCAD wants the Center Point by default. It will not accept anything but a mouse 
Left-click for the center point, a coordinate, or an Option Keyword typed in.

COMMAND OPTION PROMPTS: If a command has Options (additional things you can do within the com-
mand) they will appear within the command prompt in Brackets [Options]. To change from the Default command 
input to an option in the command prompt just type the capital letter as shown (not case sensitive) for that option.
Example: In the Circle command you could type in 3P for drawing a Circle through 3 point; or 2P for drawing a 
Circle through 2 points; or T for drawing a Circle Tangent to two objects and centering the Radius.

COMMAND <ENTER> DEFAULT OPTION: Whenever anything appears in the command prompt enclosed 
in these brackets “<>” then this is an Enter default.
Example: In the Circle command <1.0000> appears at the Radius prompt. Press Enter and you will draw another 
circle with a 1.0000 radius.

COMMAND OPTION ENHANCEMENTS: Staring in AutoCAD 2013 you are now able to select a command 
options by left-clicking on the Option at the command prompt.
Example: Start the command and the options are in gray shade with options shown in Blue text for easy viewing. 
Left-click on the option you want to change to.



38   •   Chapter 1: Learning How to Work with AutoCAD® ©CyberTek Publishing, 2014   

AutoCAD® & AutoCAD® LT Level 1

AutoCAD Text Window

AutoCAD occasionally switches 
to a Text window if there is not 
enough space to display text of 
long reports in the command 
line area.

The text window shows the 
command line history and you 
can scroll up to review previous 
command activity in the cur-
rent drawing session.

Shortcut Menus

You get the edit shortcut if 
you right-click in the drawing 
area when a command is not 
running and there are objects 
selected.

The edit shortcut is like the de-
fault shortcut except it also has 
edit options. Some edit options 
will be specific to the type of 
objects selected.

If you are in a command you 
can Right-Click and select op-
tions for that command.

Use the F2 function key to 
toggle back and forth between 
these two windows.

Default Shortcut Menu when right-
click at the command prompt and 
you are not in a command. 

Shortcut Menu when right-
click in a command. Exam-
ple: Circle command active 
- Shortcut Menu shows the 
command options

Typical Shortcut Menu when 
right-click in a Tool Palette or 
Dialog Box



Chapter 1: Learning How to Work with AutoCAD®   •   39

AutoCAD® & AutoCAD® LT Level 1

Canceling Commands

If you get into trouble you can 
normally press <Esc> to cancel 
a command.

You can also right-click (A) 
and select Cancel (B) for some 
commands.

Pick Cancel (C) in a dialog 
box to close the box without 
performing any tasks associated 
with that dialog box.

Pressing <ESC> will also 
close a dialog box and cancel 
the active command.

Undoing Commands

If you are not satisfied with 
the results of your last com-
mand you can use the Undo 
command to undo it. There 
are many ways to invoke this 
command:

• Type U and press <En-
ter>

• Hold <Ctrl> and press 
Z

• Quick Access toolbar 
button (A)

• Right-click (B) & select 
Undo (C).

• You can repeatedly use the 
U command to undo 
commands, one command 
at a time, right back to the 
beginning of the current 
drawing session.

Getting Out of Trouble

A B

C

Right-Click at 
anytime and select 

UNDO from the 
shortcut menu.

A

C
Type U at the command prompt 

or press the <CTRL>+Z

B
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Redoing Commands

You can use the Redo com-
mand to undo U and Undo 
commands. This is particularly 
helpful if you undo too many 
commands. However, you can 
only use the Redo command 
immediately after undoing 
commands.

The Redo command can be in-
voked several different ways:

• Type REDO & press 
<Enter>

• Hold <Ctrl> and press 
Y

• Standard and Quick Ac-
cess toolbar button (A)

• Right-click (B) & pick 
Redo (C)

You can select the Redo 
arrow on the Quick Ac-

cess Toolbar to redo 
one command at a time 
or the down list to redo 

back to a selected point.

Type REDO at the command prompt 
or press the <CTRL>+Y

Right-Click at 
anytime after 

doing the Undo 
command to 

REDO from the 
shortcut menu.

A

B C

GETTING HELP

As all software you can enter 
the help command by pressing 
F1 or use any of the menus in 
AutoCAD.

As all software you can search by 
documents, by words and phas-
es and a command search.

You can also start a command 
and press F1 and that will open 
the help html file to that com-
mand, as a faster way of getting 
help on a command.
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QSAVE Command

Saving your work is vitally im-
portant. You should save your 
work every 10 or 15 minutes 
or after any process that took 
time to do. You should save 
the drawing, using the QSAVE 
command.

The importance of this com-
mand is that every time you 
do a Qsave it creates a backup 
file (.BAK) with the same name 
as the drawing file in the same 
location as your drawing file.

If your drawing becomes dam-
age and can not open do to a 
cash, etc. you can rename the 
BAK back to a DWG and re-
trieve your drawing back. 

SAVEAS Commands

If you select the SAVEAS com-
mand AutoCAD will bring up 
the Save Drawing As dialog 
box, even if the file is already 
named.

You can then save it under the 
existing name or give it a new 
name and another location.

Using the SAVEAS command 
will close the existing drawing 
(without saving it) and make 
this drawing the current file in 
AutoCAD.

Note: SaveAs does not create 
a backup file like the QSAVE 
command does
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Automatic Saves

To prevent losing your day’s 
work in the event of a power 
interruption, it is a good idea 
to save your work periodically. 
AutoCAD allows you to save 
your drawing automatically to a 
file with the extension SV$. To 
turn this feature on or off, and 
control the interval between 
saves:

1) Open the Options dialog 
box (Tools>Options).

2) Switch to the “Open and 
Save” tab.

3) Check the Automatic Save 
check box to turn the fea-
ture on, and set to 30 min-
utes between saves.

AutoCAD Releases Com-
patibility

AutoCAD drawing files are 
only compatible within their 
release series.

Example: A drawing created in 
2012 can be opened and edited 
with either 2010 or 2011. This 
drawing cannot be opened in 
earlier releases of AutoCAD.

You will need to do a SAVEAS 
back to older release series in 
order for the drawing to be 
opened for editing in those 
versions.

All drawings are compatible 
going forward. A drawing from 
R-2000 can be opened in the 
2004 and 2007 series.

Note:
Make sure you have Create 
Backup Copy checked.
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Optional Hands-On

1) Select the Open a Draw-
ing Icon tool (A) from the 
Quick Access toolbar.

Optional Hands-On

2) In the Select File dialog box 
navigate to your personal 
folder (A) where all the draw-
ing files for hand-on exercises 
are stored.

3) Double left-click on 
B01_1.dwg (B) to open this 
drawing.

Exercise Objectives?
This exercise will apply some 
of the tools that were covered 
in the previous lecture.

Result:
You have used the Open com-
mand to open an exercise file to 
be used for this hands-on.

Views
Illustrations show files with the 
Detail View option. Left-click on 
the View drop-down list to choose 
other view options. You can also 
select Preview in the Views drop-
down list to show a preview of the 
selected file.

A

A

B
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Optional Hands-On

Note: The drawing file opened 
up in the same state as it was 
saved and closed in from the 
last edit session.

4) At the Command prompt 
type STARTUP <Enter>.

5) At the Enter new value for 
STARTUP <0>: type 1 <En-
ter> (A) to turn the Optional 
Startup menu on.

Result:
You have opened the drawing 
file for this exercise. And you 
have turned on the Optional 
Startup menu which will be 
used in this course.

Optional Hands-On

6) Select the Application 
Button at the top left on the 
title bar, select the Close 
option and then select the 
Close Current Drawing (A).

7) At the AutoCAD alert dia-
log box select the Yes but-
ton (B) to save changes to the 
drawing file.

Result:
You are closing AutoCAD 
and saving the open drawing 
so that it will appear in the 
Startup menu.

A

B

A
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Optional Hands-On

7) Restart AutoCAD by 
double-clicking on the 
AutoCAD Icon shortcut on 
your desktop (A).

8) At the Startup dialog box 
select the Open button (B).

9) Double-click  on the 
B01_1.dwg (B) from the Se-
lect a file section to open that 
drawing.

Result:
Using the Startup menu you 
are able to start AutoCAD and 
open the drawing you were 
working on in the last draw-
ing session without going into 
AutoCAD and then having to 
use the Open command.

Optional Hands-On

Notice that in the Model space 
you see the dimensions and 
electrical lines.

11) Select the Architectural 
layout tab (A).  Notice that 
in this layout you only see the 
dimensions.

Result:
You changed from model space 
where most of the work is done 
to a paper space layout which 
is setup for the plot drawing of 
the Architectural sheet.

Paper 
Space 

Layout Model Space 
Viewport

A

A

B

C
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Optional Hands-On

12) Go to the Home tab> 
Properties sub panel> and 
select the LIST tool (A). 

13) At the select object prompt 
left-click on the dimension 
(B) as shown.

14) Press the <Enter> key to 
change to the Text window to 
see the database for this object.

Result:
You invoked the List command 
and selected an object to view 
the AutoCAD database for that 
object.

Optional Hands-On

Notice that the list command 
opened the text window so that 
you can read the database for 
the object selected.

15) Review the information 
then when finished press 
ESC key then press the F2 
function key to return to the 
AutoCAD graphic screen.

Result:
AutoCAD will sometimes 
change to the Text window 
to show information. You can 
always press F2 to see the last 
400 lines of the command 
history.

The List command provides 
all the AutoCAD database 
information for the object 
selected. You will learn more 
about this command later in 
the course.

B

A
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Optional Hands-On

19) In the Command list scroll 
down and select the LINE 
command (A).

20) Review the Help com-
mand for this command (B).

21) Close the Help command 
window when finish.

Result:
You are using the AutoCAD 
Help command to lookup 
information on the LINE com-
mand and view how to use this 
command.

Optional Hands-On

16) Press the F1 function key 
to start the AutoCAD HELP 
command.

17) Under the Resources sec-
tion select the Commands 
option (A)

18) In the next page select the 
first letter of the command 
seeking help for (B). 

Result:
You are using the AutoCAD 
Help command to lookup in-
formation on how to use com-
mands and view the options to 
that command.

A

B

A

B
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Regenerating layout.
Regenerating model.

Optional Hands-On

22) Left-click on the Interior 
Design layout tab (A) to make 
that layout active.

23) Left-click on OSNAP (B) 
on the status bar to turn it On. 

Note: If the status buttons 
color is light blue then the 
button is on, if gray then they 
are off.

24) Left-click on the POLAR 
(C) on the status bar to turn 
it Off.

Result:
You have changed to another 
layout and turned on/off the 
status bar settings to continue 
with the next steps in this 
exercise.

Optional Hands-On

25) Start the Line command 
(Draw pull-down menu or the 
Draw panel on the Home tab 
for the ribbon).

26) Left-click toward the top 
left of the room (A) and con-
tinue to draw lines to show the 
sample plant as shown.

27) When finished drawing 
lines press <Enter> to end 
the line command.

Result:
You used the Line command 
to sketch a plant in the Interior 
Design layout inside of the 
Model Space viewport. 

A

BC

A
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Optional Hands-On

29) Select the Redo icon tool 
(A) from the Quick Access 
toolbar, also located on the 
Standard toolbar.

Note: You can also Type 
REDO <Enter> at the com-
mand prompt.

Remember: To use the Redo 
command it must be done 
immediately after the Undo 
command. If you start a com-
mand before Redo you will not 
be able to use this command.

Result:
You used the REDO command 
to bring back the last com-
mand that was undone.

Optional Hands-On

28) Select the Undo icon tool 
(A) from the Quick Access 
toolbar, also located on the 
Standard toolbar.

Note: You can also Type U 
<Enter> at the command 
prompt.

Result:
You used the Undo command 
to undo the last command 
which was the Line command 
that you used to draw the 
plant.

A

A
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Optional Hands-On

30) Start the LINE command 
(Draw pull-down menu or the 
Draw panel on the Home tab 
for the ribbon).

31) Then Press <ESC> to 
cancel the Line command to 
return back to the command 
prompt.

32) Select the QSave com-
mand from the Quick Access 
toolbar or the File pull-down 
menu.

33) Wait for further instruc-
tions.

Result:
You started a command then 
canceled out of it to and used 
the Qsave command to save 
changes to the drawing.

Command:
Command: _line specify first point:  *cancel*
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Object Snap Overrides 76, 78
Object Snap Tracking 104
Object Tracking 104
Offsetting Objects 214
OFFSET By Distance 214
Offset Command 214
OFFSET Through A Point 215
OOPS 162, 170
Options Dialog Box 26
Osnap Marker 76
OSNAP Status Bar 82
OTRACK 104, 105, 106, 107, 108, 109
Overriding ByLayer Properties 208
Overriding Color, Linetype & Lineweight 208

P

Page Setup & Plotting 385
Palette Display Views 335
Pan Real Time 56
Paper Space 33, 34, 437
Paragraph Dialog Box 295
Pline Command 141
Plotter PC3 Setup Files 411
Plotting With Layers 410
Plot Scale of Viewports 427
Plot Styles 443, 448
Plot Style Tables 443
Pointer Input Settings 115
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Points 95, 107, 128, 129, 131, 153, 346, 347, 348, 354
POINT Styles 153
Polar Distance Entry 88
Polygon 145, 456
Precise Coordinates 67
Pull-down Menus 32

Q

QSAVE Command 40
Quick Save. 40

R

Radial Dimensions 357
Ray Lines 122
Real Time Zoom & Pan 56
Rectang 145, 230, 237, 456
Redo command 39
Relative Coordinates 70, 71
Rename Dialog Box 322
Renaming Blocks 322
Renaming Layouts 436
Revision Cloud 145
ROTATE Command 177
Running Object Snaps 82, 84

S

SAVE 40
SAVE & SAVEAS 40
Saving Blocks 310
SCALE Command 177
Selecting Objects 249
Selection Preview Settings 165
Setting and Locking Viewport Scales 427
Setting Drawing Limits 94
Setting Running OSNAPS 83
Setting Up Layouts 413
Shortcut 37, 231, 238, 413
Single Line Text 273, 453, 457
SNAP Spacing 96, 97
Snap Types 96
Spacing Dimensions 365
Special Characters 288
Spell Checking 300
Stacked Fractions 293
Start, Center, Angle 132, 317
Start, Center, End 132, 136
Start, Center, Length 133
Start, End, Angle 133, 137, 218
Start, End, Direction 134, 138
Start, End, Radius 134
Startup Dialog Box 68, 98
Startup Menu Buttons 21
Stretch Dimensions 389
Style Command 275
Symbol Library Palettes 332

T

Tan, Tan, Radius 129
Tan, Tan, Tan 130
Text Formatting Toolbar 287
Text Window 37
Toolbars 30, 32
Tooltip 32, 76, 112, 116, 438
Tooltip Appearance 116
Tool Palettes 33, 332, 450, 458
Trans-Spatial Dimensioning 383
Tree View Toggle 334
Trimming & Extending Objects 219
Trim Command 219
Trim Mode 231, 238
Types of Osnaps 77

U

Undoing Commands 38
Undo Option 120
Updating Dimensions 375
Using Divide 155
Using Dynamic Input 112, 113
Using Grid and Snaps 94
Using layers 183
Using Measure 155
Using Object Snaps 76
Using OTRACK 104
Using Points 153

V

Viewport Display (or Plot) Scale 428
View Magnification 51

W

WBlock Command 310
What Are Blocks? 307
Why Use Blocks? 308
WPolygon 164

X

XYZ Axes In 3D 66

Z

Zero Length Chamfer 238
Zero Radius Fillets 231
Zoom And Pan With Intellimouse 64
Zoom Command 52
Zoom Extents 54, 458
Zoom Object 54, 458
Zoom Previous 53, 58, 59, 318, 458
Zoom Realtime 55, 56, 62, 63, 458
Zoom Scale 55, 61, 458
Zoom Window 52, 67, 458
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